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Timelapse Template Guide
A reference guide to Timelapse templates, and how to create them 
with the Timelapse Template Editor 1

This guide assumes that you have first gone through the Timelapse 
QuickStart Guide, which is Part I of this series. That guide provides 
basic information on how to use Timelapse, the role of templates, 
and the Timelapse Template Editor. This guide builds upon that, 
where it adds details.

The Timelapse Template Guide explains how to use the Timelapse 
Template Editor  (included with the Timelapse Software). The 
Template Editor allows you to create a template (a file with the .tdb 
suffix ) that specifies the tags you want to track. Timelapse then uses 
that template 

•	 to create the data fields that appear at the top of the Timelapse 
window, which the analyst fills in with tagging data, and 

•	 to structure the database columns that will hold your tag data, 
and  

•	 to decide what fields to export to a CSV file 

Creating and modifying templates is easy, as its mostly a matter of 
form filling once you decide upon the relevant tags for your project. 

Finally, we recommend watching Video tutorial: The Timelapse 
Template Editor (available on the Timelapse web site videos page), 
which illustrates many of the functions described in this guide.

1What you see when you run Timelapse software may not exactly 
match the screen images in this guide, due to updates made in the 
software after these screen images were taken. These differences 
should not affect your general understanding.
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Introduction
The kinds of information and things that you or your organization want to 
track and count as tags will be specific to your domain, your project and its 
goals and purposes, the kinds of images you want to analyze, and even the 
particular data you want to get out of it. Across domains, tags will certainly 
differ. For example, a wildlife oriented ecology domain may want tags such 
as Species and Count, while a fisheries domain may want tags such as #Anglers 
and #Boats. Tags may even differ within a domain. One wildlife project may 
only be concerned with the presence of certain predacious species. Another 
wildlife project may want a broader set of tags specifying all species in the 
area, the sex and age of each entity, the presence of vehicles and people, 
and other factors such as weather and ground cover.

This is where the Timelapse Template Editor and the template file (a file with a 
.tdb suffix) come in. A project manager uses the Template Editor to specify 
the data fields the analysts will use to tag each image, which is saved as a 
template file. That template file is then deployed (copied) to the root folder 
of an image set. When Timelapse loads that template and image set, it uses 
the specification contained within the template to create the look and feel of 
the fill-in data fields that appear in the Timelapse window's interface, and to 
structure how tag data will be stored in the Timelapse database (.ddb file). 

The Template Editor defines several mandatory data fields that must be 
included in all templates. Beyond that, any data field can be defined as long 
as it conforms to one of the four available data types: Notes for free text, 
Counts for integers, Flags for true/false, and Choices for displaying a limited 
set of choices as a menu. This means that Timelapse can be customized to 
a broad variety of domains and purposes. It also explains why Timelapse 
has been used for many different purposes: wildlife ecology, fisheries 
management, social studies, laboratory instrument monitoring, and more.

Internally, the template .tdb file is actually an SQLite database, where the 
data fields you specified is saved in a database table. However, you don’t 
have to know anything about SQL or databases, as the Template Editor takes 
care of all the grotty technical details.

While there is some overlap between this guide and the Timelapse 
QuickStart Guide, this document goes into much more detail about the 
template and how the Template Editor works. 

Creating the right template for your needs
You should give considerable thought to the information you want to capture 
as tags and how it is structured as data fields. When you craft a template, 
you are essentially creating a standard that specifies: 
•	 what analysts should look for and tag when inspecting the images; 
•	 how data fields are labeled in the Timelapse interface, where the labels 

and the tooltip help messages associated with them should be in the 
analyst's terms; 

•	 how the tags entered by analysts are named and recorded in the 
Timelapse database (.ddb) file as data;

•	 which data should be exported to a .CSV file;
•	 the expected format of the data;
•	 what data will be available for statistical analysis;
•	 the expected number of tags the analyst must consider: the fewer the 

data fields for the analyst to fill in, the faster the tagging task.

Doing it right requires planning. We recommend you talking others in your 
organization to understand their needs. Test your templates, ideally with 
experienced analysts who can give you feedback, before deploying them 
widely.  Tag a sample image set to collect some data, and see how amenable 
that collected data is to later analysis (e.g., statistics). 

How to deploy templates
A project manager, or whoever is in charge, usually creates a master 
template, which is just the template .tdb file produced using the Template 
Editor. That template normally serves as the standard for how all images in 
that project should be analyzed and tagged. 

The file can then be deployed in various ways. A common approach simply 
copies  the template into the root folder of one or more image sets: how 
you decide to divide your images into images is, of course, up to you. When 
Timelapse loads the template in that image set, it will use the template 
found in the root folder to construct the Timelapse interface, and to create 
a Timelapse Data database .ddb file, which in turn will hold the tagging data 
for that image set. 

There are many variations to the above, as it depends on how you plan to 
deploy Timelapse. The Timelapse FAQ web page includes an entry discussing 
various other deployment strategies. 

https://saul.cpsc.ucalgary.ca/timelapse/pmwiki.php?n=Main.FrequentlyAskedQuestions
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The minimal template
This section explains several Template Editor fundamentals by creating and 
deploying the minimum template required to use Timelapse.

To follow along with this exercise, copy the Station2 folder (which includes 
the Fetched-2016-04 sub-folder) from the PracticeImageSet folder to a 
convenient location such as your desktop. 

Creating the minimal template
1.	 Start the TimelapseTemplateEditor. A window appears displaying brief 

instructions. 

2.	 Create a new template. Select File | New template..., navigate to your 
Station2 folder and click Save. 
	» The Template Editor window will display the required data fields. 
	» A new file titled TimelapseTemplate.tdb should appear in 

your Station2 folder. The template includes the mandatory 
data fields required by Timelapse along with their default 
settings. Cells in grey are not editable, while cells in white 
are editable. These mandatory controls cannot be removed

. 

3.	 Quit the editor. Start Timelapse. Select File | Load template, images and 
video files.... Navigate to the newly created TimelapseTemplate.tdb file in 
the Station1 folder. This loads the template and all images in that folder. 

4.	 Compare the fields in the Template with the fields in the Timelapse Data 
Entry panel above. There is a one to one match. 
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Editor and minimal template explained
The Template Editor interface
The Timelapse Template Editor interface contains four main areas, as illus-
trated below.

•	 Data field editor (top). Each row in this area specifies a single data field 
item and its attributes. 

•	 User interface preview area (lower middle) shows how the data will be 
displayed as fields in the Timelapse user interface. 

•	 CSV preview area (bottom) shows the data column names and their order 
when data is exported to a .CSV file.

•	 Row addition/deletion controls (right) are buttons that let you add or 
remove particular types of rows into the table. 

Mandatory fields
Every template includes four mandatory data fields, each displayed as a row 
in the table.  Each row specifies a different data type as detailed in the Type 
column. For the first three mandatory fields below, Timelapse will automati-
cally fill in the data when it loads your images. 
•	 File: name of the image file. 
•	 RelativePath:  path from the root folder to the sub-folder containing the 

image, if any.
•	 DateTime: date and time the image was taken, extracted from the file's 

metadata or file creation time. 
•	 DeleteFlag: allows the analyst to ‘flag’ particular images for later deletion

Four other data types are also available: Counters, Choices, Notes  and Flags. 
We will shortly show you how to use these to create custom data fields 
specific to your project.  

Data field attributes 
Each data field has several attributes, presented as columns in the data table.

•	 Default Value is the initial value of that data when images are first loaded 
into Timelapse. The value can be empty. 

•	 Label is used to label the data field when it is displayed in the Timelapse 
user interface. Labels can comprise any text, and can be the same or 
different from the DataLabel attribute. 

•	 DataLabel names the database column that stores the data in the 
Timelapse database .ddb file.  The DataLabel also appears as the column 
name in the Timelapse Data Table tab, and the exported .CSV file. 
DataLabels must be unique, and its text can only comprise a mix of 
alphanumeric letters and ‘_’. 

•	 Tooltip defines the text displayed in the Timelapse interface when the 
analyst hovers their mouse over a data field. Its purpose is to serve as a 
brief help message explaining what that data field is for.

•	 List applies only to Choice items. A list defines a textual list, whose values 
are used to create the Choice drop-down menu associated with each 
Choice. This will be demonstrated shortly. 
Note. The DefaultValue of a Choice row must be either empty, or must 
match an item in the Choice's List. Mismatches will result in a warning 
dialog.
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•	 Width defines the width of the text box associated with data field. While 
the units are somewhat arcane, you can see the result of changing the 
width in the user interface preview area. Ideally, the width will be just 
wide enough to display expected values. 

•	 Copyable defines whether that field is affected by the Copy previous 
values button in the Timelapse interface. When the Copy previous values 
button is pressed, only those fields marked as copyable will have its data 
copied from the previous image to the current image.  

•	 Visible defines whether the field should be displayed in the Timelapse 
user interface. If marked as invisible, fields and their default values 
will still appear in the Timelapse data table and the exported .CSV file. 
Marking fields as invisible is useful for several reasons.

	» Hiding fields not used or unneeded by the analyst reduces clutter in 
the Timelapse data entry panel.

	» Fields can be filled in with a constant default value across all images, 
where there is no need for an analyst to see or change those values. 
As an example, each image may be tagged with the name of the 
organization that owns it, such as by creating a Note field labeled 
‘Organization’, its DefaultValue set to that organization’s name, and 
its Visible state to unchecked. While it won’t appear in the Timelapse 
data entry panel, it will be included in the database and exported .CSV 
file.

•	 Export defines whether a field and its values should be exported to a .CSV 
file. This is useful to exclude unneeded fields from the exported data, 
such as those that will not be used for later analysis. For example: 
	» 	because the DeleteFlag is used internally to tag images that Timelapse 

should delete, its Export attribute is unchecked by default. This is why 
it is not included as a column in the spreadsheet preview area.

	» because File and RelativePath are required by a CSV row to identify 
the name and location of the image or video file, its Export attribute is 
checked by default and cannot be edited. 

You cannot delete mandatory data rows (i.e. those who are colored gray). 
However, you can edit some of their properties, as will be shown shortly. 
Editable fields are displayed in white, while non-editable fields are in gray.

Customizing the template
Aside from the mandatory data fields, you can create your own custom data 
fields specific to your project. The field can be one of four data types.    
•	 Counters are restricted to blanks or positive integers. They are normally 

used for counting entities in an image, e.g., number of deer. 
•	 Choices offer a fixed set of textual items presented in a drop-down menu. 

Choice values are restricted to text matching those items.
•	 Notes are for free-form text,and can include any values
•	 Flags are for setting true / false values. The checkbox control that appears 

for flags stores data as  true when checked, or false when unchecked.

To explain, assume you would like your project to include the following tags. 
Data label Type Default value Purpose Choice items
Species Choice Identifies wildlife Bear, Bobcat, Coyote, Wolf, Empty
Number Count 0 # wildlife present

Comment Note Any comment
Publicity Flag false A great photo
Organization Note Wildlife, Inc. Organization name

Also assume you do not want the Organization fields to be visible in the 
Timelapse interface, because it will be automatically filled in (via its default), 
because the analyst will not be changing that field, and to reduce clutter. 

1.	 Click the Choice, Count, Note, Flag and then Note buttons to create five 
new rows of specific types. The preview areas show how they would 
appear in the Timelapse user interface and in the exported .CSV file.
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2.	 Edit each row to set each field's attributes, which includes setting a more 
meaningful label to Number and Publicity. At the same time, turn off 
the visibility for the Folder, ImageQuality and Organization: they will 
disappear from the user interface preview area, but are still present in 
the .CSV preview area. Finally, turn off Organization's Copyable attribute.  

3.	 Add Items to the Species Choice List. Click the Define List button, which 
raises a list editor. Type the species into the list, one per line. Because 
you also want the option to have this field set to empty, click the option 
Include and 'empty' item. This will add a blank entry to the drop-down 
menu when it appears in Timelapse. If you want to set a default values for 
your choice, it must match one of the items in the list. 

4.	 Adjust the user interface, if desired.
	» Double the width of the Comment field by setting its Width to 200. 

You will see the results immediately in the user interface preview area.
	» Move the Delete? field to the end of the user interface by clicking 

and dragging the Delete? label in the user interface preview area, and 
dropping it atop the last data field Publicity?. 

5.	 Rearrange the order of columns as they would be written to a .CSV file 
and displayed in a spreadsheet, if desired.
	» In the CSV preview area drag the DeleteFlag field and drop it to just 

after the Organization field.

6.	 Test the results in Timelapse. 
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Other Template Editor Features
A few other features are available in the template editor, all accessed via the 
menu bar at its top. 

The File menu is mostly self-explanatory, except for two things.
•	 There is no 'Save template...' as everything is automatically saved to the 

template .tdb file while editing.
•	 Upgrade Timelapse files to latest version... is used to bulk-upgrade old 

selected Timelapse files (i.e., pre version 2.3) to the current version. 
Alternately, Timelapse will inform you if you are attempting to open an 
old file, and will raise the appropriate dialog to let you upgrade it. This 
menu item will disappear in the future.

The View menu is operational when editing a template.
•	 Inspect File Metadata... raises a dialog that allows you select a typical 

image set file, and inspect the metadata that file contains. Its purpose is 
to let you see if any file metadata is worth recording. If so, you can create 
a Note data field, where you can later have Timelapse automatically 
load each file's metadata value into that field.  For example, if the file 
contained metadata for Ambient Temperature, you could create a data 
field called Temperature, where Timelapse will populate that field with 
each file's Ambient Temperature value.

•	 Show all columns... displays other non-editable data columns used by 
Timelapse. While useful for debugging, they are likely of little interest to 
most people. 
	» ID: The internal database ID of each row
	» Control order: the sort order for displaying controls in the Timelapse 

user interface
	» Spreadsheet order: the sort order for the columns in the .CSV file. 

The Help menu should be self-explanatory. You can use it to: 
•	 quickly navigate to various pages on the Timelapse web site, 
•	 view various video tutorials,
•	 join or send email to the Timelapse mailing list,
•	 find more about the Timelapse version you are running, including the 

ability to update to the latest version.

Modifying templates after they are used
There may be times when you want to change a template after its been 
deployed and used to tag images in an image set. For example:
•	 an analyst has an image set with a TimelapseTemplate.tdb in it and has 

begun analyzing those images. 
•	 The analyst (or perhaps someone else) changes the template, perhaps to 

add or delete data fields, or to change the attributes of some data fields. 
•	 The analyst then reopen the image set for further analysis using the 

modified template.

The good news is that Timelapse tries to accommodate changes to the 
template, where most modifications are easily managed. Timelapse always 
checks your template for changes, and will notify you (via a dialog box) of 
any implications that your modifications may have on your stored data, along 
with various choices to carry through or abort the operation.

Note: modifications involving changes to the DataLabel require special 
care, as the DataLabel defines how data is stored and retrieved in the 

Timelapse database.

Modifying a data field's appearance and order 
Most modifications to a data field's attributes only alters how that field 
appears or is ordered as a control in the Timelapse interface. These modifi-
cations do not affect how your existing and future data is stored and used. 
Consequently, changes will be applied automatically when you reload an 
image set with a template whose fields are modified as follows. 
•	 edit and alter the text in any field in a row EXCEPT Data Label; 
•	 change a field’s Copyable, Export, Visibility or Width;
•	 change the position of data fields in the interface; 
•	 change the position of data fields in the .CSV file;
•	 add items to the Choice menu.

Adding and deleting rows or renaming data labels
Adding rows is safe. In contrast, deleting rows or renaming data labels have 
implications to the data already stored in a previously created image set, as 
these may affect the data label used to store your data. 



- 9 of 9 -Timelapse Template Guide Timelapse Manual Series: Part 3

•	 Adding a new data field defines a new control that will appear in the 
Timelapse interface, and a new data column in the database and .CSV file. 
This is a safe operation, as it does not affect any existing data.

•	 Deleting an existing data field indicates that you are no longer inter-
ested in that control or the data associated with it. The data field's control 
will no longer appear in the Timelapse interface. Importantly, any previ-
ously entered data associated with that data field will be deleted from the 
Timelapse database, and consequently not exported to the .CSV file. 
Note. If you want to keep the data, then just uncheck the control’s 
visibility field instead of deleting it.

•	 Renaming a control by changing its data label leads to ambiguity when 
the template is opened in Timelapse. It can be interpreted as:
	» deleting that row, and then adding a new row. This would delete the 

data associated with the original data label;
	» renaming that row, which retains and associates the data with the new 

data label.  

As Timelapse cannot tell which possibility has occurred, it will raise a 
dialog box asking you to decide which action to take. For example, if you 
changed the DataLabel of Publicity to GreatShot, Timelapse will warn you 
and ask you what it should do. If you wanted to keep the data previously 
associated with Publicity you would click on Rename and select GreatShot 
from the drop-down menu.  

Deleting and renaming items in a Choices' list
A Choice field's list is used to display a selectable menu of possible values for 
that field. Furthermore, Choice fields can only display text that match at least 
one of its menu items. Consequently, if you use the template to delete or 
change the name of an item in the Choice list, Timelapse will detect this and 
will warn you in a dialog. It will say that cannot display previously entered 
text that matches the missing item(s). 

Even so, no data is deleted. While Timelapse cannot display that text in the 
data field if it differs, it still stores the original text in the data base.
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